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About FabFilter Saturn
The distortion effect has played a huge role in music history. By driving and distorting a
guitar amplifier, rock-
and-roll was born in the 1960s! Since that day, distortion has been used
in many forms, and not only to get
that crunchy electric guitar sound. Today, distortion is used
to color sounds in various ways while mixing, by
driving vacuum tubes, saturating tape and even
by reducing bit rate.

FabFilter Saturn offers various flavors of distortion, and combines it with multi-band audio
processing and
virtually endless modulation possibilities. From subtle, clean and warm tube or
tape saturation to the wildest
multi-band guitar amp effects: FabFilter Saturn delivers!

 

Key features include 16 different distortion styles, from subtle saturation to heavy guitar
amps and bit
crushing, multi-band processing (up to 6 bands), per-band drive, mix, feedback,
dynamics, tone and level
control, plus tons of modulation options with XLFOs, Envelope Followers,
Envelope Generators, MIDI Sources
and XY Controllers.

FabFilter Saturn is available in VST, VST3, AU (Audio Units), AAX Native and AudioSuite formats (all both 64-bit
and 32-bit).

Windows requirements

32-bit: Windows 10, 8, 7, Vista or XP

64-bit: Windows 10, 8, 7 or Vista (x64)

VST 2/3 host or Pro Tools

macOS requirements

OS X 10.8 or higher

AU or VST 2/3 host or Pro Tools

Intel processor

Next: Quick start

See Also
Using FabFilter Saturn
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Quick start
The installer will copy the FabFilter Saturn plug-in into the common VST, VST 3, AU (macOS only)
and Pro
Tools plug-in folders on your computer. On macOS, the global plug-in folders in
/Library/Audio/Plug-Ins are
used.

In most cases, your host will then recognize the plugin automatically. However, if the
instructions below do not
work, see Manual
installation instead.

Cubase
Choose an empty insert slot, for example in the Mixer, and select FabFilter Saturn from the menu that
appears. To use the MIDI features in Saturn, create a new MIDI track and set its output to the Saturn
instance you have just created. (The VST 3 version of Saturn can be found in the Distortion section.)

Logic Pro
Choose an empty insert slot on one of your audio tracks, instrument tracks or buses and select
FabFilter
Saturn from the pop-up menu. You will find FabFilter Saturn in the Audio Units > FabFilter section
(named FF Saturn).

Ableton Live
In Session view, select the track you would like to place FabFilter Saturn on, for example by
clicking the
track name. At the left top of Ableton Live's interface, click on the Plug-in
Device Browser icon (third icon
from the top). From the plug-ins list, double-click
FabFilter/FabFilter Saturn, or drag it onto the track.

Pro Tools
Choose an empty insert slot on one of your audio tracks, instrument tracks or buses and select
FabFilter
Saturn from the pop-up menu in the Harmonic section.

Use the Presets button at the top of the plug-in interface to try different settings from the
many factory presets
that are bundled with FabFilter Saturn. Have fun!

Next: FabFilter Saturn overview

See Also
VST plug-in versions
Loading presets
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Overview
FabFilter Saturn's interface is divided into multiple sections:

Presets, undo, A/B, help
The Undo, Redo, A/B and Copy buttons at the top of the plug-in interface enable you to undo
your
changes and switch between different states of the plug-in. With the preset buttons, you
can easily
browse through the library of factory presets or save your own settings so you can
re-use them in other
songs. The Help button provides access to the help file and other
information and options.

Interactive multi-band display
Via the interactive display, you can directly create and select
frequency bands. At the same time, it's a
real-time frequency analyzer, making it easy to
decide where to set the cross-over frequencies.

Band controls
Using the band controls, you can adjust the settings of the
selected bands. For each band, you can
separately adjust the distortion type, drive, feedback
settings, dynamics, tone, level and mix settings.

Modulation button
The modulation button shows or hides the entire modulation section at the bottom of the
interface.
FabFilter Saturn offers virtually unlimited modulation possibilities, but all this
power might be a bit
intimidating. That's why the modulation section is hidden by default, and
you can look 'under the hood'
when you want to tweak a preset or design your own.

Source selection bar
The source selection bar shows all modulation sources at a glance and lets you easily scroll
around and
create new sources. FabFilter Saturn offers XLFO, Envelope Generator (EG), Envelope Follower (EF), MIDI
and XY Controller sources. See also
Modulation.

Modulation slots and sources
The bottom section contains the modulation sources. The modulation section in Saturn is fully
modular —
but without the cables! We found a simple way to show you everything that is
modulating, and what is
modulated by what. Above each modulation source, the modulation slots
show exactly what targets are
modulated by this source and let you adjust the amount of
modulation. You can very easily set up
modulation connections with drag-and-drop. All in all, we think we made sound design easier
and more
fun!

MIDI Learn, channel mode, input/output options
The bottom bar contains the MIDI Learn feature which sets up any
MIDI controller to control any plug-in
parameter. Next, we find the channel mode option for
Mid/Side channel mode, the auto-mute feedback
option, HQ
mode, audition and input/output/mix controls. See Input/output
controls.
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Resize
The resize button in the lower-right corner lets you choose between normal and wide interface
layouts.
The wide layout eliminates scrolling in the top part of the interface and provides
more space for the
modulation sources at the bottom of the interface. Most hosts support
dynamic resizing of the interface;
otherwise just close and re-open the interface window.

Next: What-you-use-is-what-you-see

See Also
Quick start
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What-you-use-is-what-you-see
Often an impressive feature list results in an impressively difficult-to-use interface full of
controls for
parameters you might never even use. For almost every plug-in developer one of the
greatest challenges when
making a complex full-featured plug-in is to design an interface that is
easy to use. And we think we did it!
FabFilter's interface concept:
What-you-use-is-what-you-see.

The idea is simple yet powerful. At all times, the interface only contains the modulation
sources and slots that
you are actually using. You can even hide the complete modulation section
if you only want to browse presets,
and don't feel the need to look 'under the hood'! This
results in an intuitive user interface that experienced
producers and novices alike will
embrace.

And if you need power, it's at your fingertips. Do you want another XLFO? Just add one! Do you
want an
envelope generator? Just add one and start modulating things! Of course there is a limit
to the number of
sources you can create, but in practice it feels like you can create as many
sources as you will ever need.

To give you an idea, here's a simple preset with just a single frequency band and without
modulation. We've
chosen to hide the modulation section with the Modulation button. It looks like
this:

... while a more complex preset, with various modulation sources and frequency bands looks
like this:

7



To help you understand even the most complex presets, modulation slots are grouped with each
source. Each
component, knob or controller that is being modulated is marked with a little
M button. Simply click the M to
highlight the modulation source
and slots responsible for the modulation. See also Modulation.

Next: Knobs

See Also
Modulation
Overview
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Knobs
It is easy to control FabFilter Saturn's parameters with the large round knobs. They will light up when you
move the mouse cursor around to indicate that you can adjust them. The moment you move the mouse cursor
over a knob, a parameter value display will pop up, which shows the name and the current value of the
parameter.

All knobs support four ways of control:

1. Vertical mode
Click on the center area of a knob and drag up or down to rotate it. The knob reacts to the
speed with
which you are dragging, so if you move the mouse slowly, you make precise
adjustments.

2. Rotate mode
Grab the arrow of the knob and drag it around. By moving the mouse cursor further away from the
knob while dragging it, you can make precise adjustments.

3. Mouse wheel mode
Perhaps the easiest way to make adjustments is by using the mouse wheel when you hover over a
knob. This mode works for all the knobs and possible panning rings. (On Windows, you might need
to
click in the plug-in interface first to make sure it is the active window.)

4. Text entry mode
Double-click a knob to enter an exact value using the keyboard.

Tips

To reset a knob to its default position, hold down the Ctrl key (Windows) or
Command key (macOS) and
click the knob once. Note: In Pro Tools, Saturn uses the
default Pro Tools keyboard shortcut for reset:
Alt+click.

To fine-tune a value when using vertical drag mode or the mouse wheel, hold down the
Shift key while
dragging or moving the mouse wheel. Note: In Pro Tools, Saturn uses the default Pro Tools keyboard
shortcut for fine tune: Ctrl+drag on Windows or
Command+drag on macOS.

There are several handy shortcuts in text entry mode. With frequency values, you can
type e.g. '1k'
to set the value to 1000 Hz, and also 'A4' for 440 Hz, or even strings like
'C#3+13'. With dB values, you
can type e.g. '2x' to get +6 dB (the value that corresponds to
two times louder). With all values, you can
also type a percentage (e.g. '50%' will put a knob
exactly in the middle position).

Sometimes, knobs in our plug-in interfaces are linked: these be adjusted
simultaneously by holding
down the Alt key (Shift key in Pro Tools) while
dragging on one of them. For example, an output level
and input level setting of a plug-in
could be adjusted simultaneously (in the opposite direction) this way.

Next: Interactive multiband display

See Also
Overview
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Interactive multiband display
FabFilter Saturn's top section consists of a large interactive multi-band display, which makes
it very easy to
create and select frequency bands and adjust their level and drive settings. At
the same time, it's also a real-
time frequency analyzer.

To add a new frequency band, simply click on the small '+' button that
will appear at the top of the
display when you hover the mouse over it. By clicking this
button, the current frequency band splits with
a crossover frequency at the current mouse
position. The new band will copy its settings from the band
that has just been split.

Simply click anywhere in a band to select it.

Click and drag on the display background to select adjacent bands by
dragging a rectangle around
them.

Hold down Ctrl (Windows) or Cmd (Mac) and click in another band to
add it to the current selection or
deselect it instead. Hold down
Shift and click in a band to select a consecutive range of
bands.

If only one band is active, it will be selected by default and the band controls are automatically linked to that
single band. Once you have
multiple frequency bands available, the display highlights the level buttons of the
selected
bands and the band controls are linked to these bands. In the
screen shot above, the middle band is
selected. In addition, the band controls will slide
underneath the selected band.

Click and drag a selected level button vertically to adjust the level
setting of all selected bands. If you
have multiple bands selected, the level of all selected
bands will be adjusted with the same relative
change.

Use the mouse wheel to adjust the drive setting of the selected bands.
This works while dragging the
level button or when the mouse pointer is anywhere above a band.
Alternatively, hold down Ctrl
(Windows) or Cmd (Mac) while dragging the level
button to adjust the drive instead.

Hold down Shift while dragging to fine-tune the settings of the
selected bands.

Hold down Alt to adjust all bands at once, regardless of the
current selection.

To change a crossover frequency, click and drag the vertical crossover split.
Alternatively, click and drag
a level button horizontally to change the crossover frequencies
at both edges of the band.

Double-click a level button or a crossover split to type a level value or frequency
directly.

Tips

About everything in the display can be modulated, even the cross-over splits. Simply
drag and drop a
modulation source to it!

Solo and mute

If you hover the mouse over the top of the display and there is more than one
band, small solo and mute
buttons in the left-top corner of
each band will appear. The solo button lets you listen to a single band, while
the mute button
does the opposite and mutes the band, letting you hear all other bands. Of course, you can
solo
or mute multiple bands at the same time, just like it works with tracks in your DAW.

Hold down the solo or mute button to solo or mute a band only temporarily, as long as the
mouse button
is pressed.
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To solo or mute a band exclusively, Ctrl-click (Windows) or Cmd-click
(Mac) the solo or mute button.

Solo and mute changes can be automated and are saved with the other parameters, so you can
also use them
for creative effects.

Next: Band controls

See Also
Overview
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Band controls
FabFilter Saturn contains one set of controls to adjust the currently selected frequency
bands. When only one
band is used, it will be selected by default and the controls are automatically linked to that single band. Once
you have multiple
frequency bands available, the display highlights the level buttons of the selected bands and
they are linked to all of them.

From left to right, the following parameters are available:

The Enabled button lets you easily bypass the selected frequency bands.
When bypassed, the dry input
signal of the band is passed to the output straight away. Note
that you can also solo and mute bands with
the solo/mute buttons in the display.

The Section Preset button lets you quickly save or restore the parameters
for the selected bands. See
Section presets.

The Mix sets the combination of unprocessed (dry) signal and the
processed/distorted signal for the
band.

The Feedback Amount knob sets the level of feedback for the band, which
feds the processed audio
back into the input of the band. The Feedback
Frequency knob sets the ringing frequency of the
feedback loop. You can simply compare
this to the distance of a microphone which picks up the signal of
an amplifier that outputs its
own signal: the closer the mic gets to the speaker, the higher the ringing
frequency.

The Dynamics knob can be used to either gate or compress the band signal.
Turning the knob to the
right will add heavily pumping compression, while turning the knob to
the left will introduce great all-
purpose gating/expansion.

The Style button selects the type of distortion applied to the signal. You
can choose between:

Tube emulations: from clean, high quality tubes to juicy or even
broken tube sound.

Tape emulation: subtle, warm or extreme tape saturation.

Amplifier emulation: from smooth and crunchy amplifiers to screaming
power amps.

Smudge: This creative distortion algorithm smudges and stretches the
audio in weird and
unexpected ways. The Drive knob sets the amount of
smudging/stretching.

Rectify: A crunchy combination of rectified sound, DC offset removal
and soft clipping.

Destroy: A destructive combination of bit-crushing, sample rate
reduction and clipping.

The Drive knob is obviously one of the most important parameters, setting
how much the clipping stage
is driven with input signal. While increasing the drive, the output
level will be adjusted automatically, to
ensure that the overall sound level doesn't get out of
control. With the pan ring, you can change the
balance of the drive amount
between the stereo channels (see also Mid/Side
processing).

The Tone controls set the bass, mid, treble and presence of the processed
band signal, allowing you to
tweak the harmonics generated by the distortion algorithm.

The Level knob sets the output level of the selected bands between minus
infinity and +36 dB. With the
pan ring, you can change the relative levels of
the left and right audio channels (or mid/side when
Mid/Side processing is active).

The Remove button deletes the currently selected bands.

Tips

If there is more than one band, you can also easily adjust the level or drive settings of
any band via the
interactive multiband display.

All continuous band parameters can be modulated, of
course!

When adjusting band settings with a continuous range (for example Drive, Level, Dynamics)
for multiple
selected bands at once, the relative differences between the bands will be
preserved. When adjusting
discrete parameters (HQ, Distortion Style), the parameter for all
bands will be set to the same new value.
If you double-click a knob to enter a value, this
value will be applied to all bands directly as well.

Next: Modulation

See Also
Overview
Interactive multiband display
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Modulation
The real fun with FabFilter Saturn starts with the incredible modulation options. Almost any
parameter can be
modulated. These are called modulation targets. They can be
modulated by any of the available modulation
sources: XY controllers, XLFOs, envelope
generators, envelope followers and MIDI
sources. The modulation
signal always flows via a modulation slot that
allows you to vary the extent of modulation.

Use the Modulation button at the top to show or hide the entire
modulation section, which consists of the
following elements:

Source selection bar
The source selection bar shows a schematic overview of all modulation sources at all times.
Simply click
on a source button here to scroll the source into view. The highlighted section of
the bar shows the
currently visible part, and it can be dragged to scroll the sources as well.
The top segment of each source
button lights up according to the modulation signal it is
currently sending.

Modulation slots
As said before: every modulation source uses a modulation slot to send its signal to the
target. Saturn
always groups all modulation slots above the source that they're connected to.
Each slot displays the
destination, graphically shows the amount, and you can quickly turn it
on or off, or reverse its output.

Modulation sources
The modulation sources are organized in a horizontally scrolling strip below the source
selection bar.
There are 5 different kinds of sources available: The XLFO can generate almost any waveform you can
imagine and can be synchronized
to the host tempo. The Envelope generator is of the usual ADSR kind
and
triggered by audio or MIDI. The Envelope follower will follow the
loudness of the incoming audio or
side-chain signal. The MIDI
source transforms any incoming MIDI data into a modulation signal. Finally,
the XY controller lets you modulate two targets using horizontal and
vertical mouse movements.

To add a modulation source, click the + button in the source selection bar.

To delete a modulation source, click the remove button  in the top right corner in the source
interface.
When a source is deleted, modulation slots that use that source will also be
deleted automatically.

Tip: You can scroll the modulation source section with the mouse wheel. On
Windows, most mouse wheels only
work vertically, but you can hold down the Ctrl and
Shift keys for horizontal scrolling in that case.

Next: Drag-and-drop modulation slots

See Also
Overview
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Drag-and-drop modulation slots
One of the best features of FabFilter Saturn is undoubtedly the ability to set up modulation
connections with
drag-and-drop. There is no need to search through long drop-down menus
containing dozens of sources and
targets or to find your way in cluttered and obscure matrix
views. This simple method of making modulation
connections makes sound designing become fun, easy
and, above all: fast. So how does it work?

Grab a source... ... drag it to a target... ... and drop it.

First, grab the source drag
button that you would
like to
use as a modulation signal, for
example XLFO 1. The moment
you click on the source
drag
button, the interface dims and
all modulation targets are
highlighted.

The moment you start dragging,
you will see a line from the
source drag button to the
icon
that you are dragging. If you
hover the mouse over the bands
in the display or source
selection
buttons they will automatically
be activated. The mouse cursor
will snap to any
available
modulation target.

Now drop the icon on the
highlighted knob of the
parameter that you would like
to modulate, for example the
Drive knob of Band 2.
That's all
there is to it!

If you wish, you can also add a slot manually using the small plus button above each
modulation source. You
can also modulate slot level knobs, which makes incredibly complex
modulation setups possible. To sort the
slots click the + button in the source selection
bar and select Sort Slots from the menu that pops up.

Once a slot has been added, you can edit it:

Use the Level slider to adjust the amount of modulation. Like with knobs, hold down Shift for fine-tuning;
hold down Alt to
adjust all slot levels for the same source; Ctrl-click (Windows) or
Command-click
(macOS) to reset the level to the default value.

To the left of the Level slider, you can invert the modulation signal with the +/-
button.

When you hover over the slider on the left an on/off button appears. Use this to
temporarily disable the
slot. On the right a menu is accessible that gives direct access to all
available modulation targets.

To delete the slot, click the Remove button  to the right of the Level slider.

Our what-you-use-is-what-you-see interface makes complex programming very easy. Saturn uses
dynamic
slot highlighting to visualize all the sources that modulate a specific
target. When a parameter is modulated a
small modulation indicator
"M" appears:

Click the M modulator indicator to highlight all slots that modulate this
target. In the source selection bar the
sources that modulate the target are also
highlighted.
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This feature makes programming so much more fun because it's easy to see what is happening
inside a patch.
To return to the normal interface click anywhere on the interface background or
click the modulation indicator
again.

When a modulation indicator appears in a band in the interactive
multiband display or envelope generator, this
means one or more
parameters of that band or EG are modulated. When you click that indicator it will highlight
all
slots that modulate a target of the band or envelope generator.

Next: XLFO

See Also
Modulation
What-you-use-is-what-you-see
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XLFO
The XLFO is like a classic LFO but it can do so much more! It can also be used as a 16 step
sequencer with an
individual glide parameter for every step. The display shows the waveform that
is used by the XLFO. Steps can
be freely added or deleted to shape the funkiest of waveforms.

To add an XLFO as a modulation source, click the + button in the source selection bar and click New XLFO.

At the left of the XLFO interface, you find the global parameters that affect the entire
waveform:

Frequency
The frequency knob sets the time it takes for 1 cycle of the waveform to complete. This
knob is a
modulation target, so you could let one XLFO modulate the frequency of another
XLFO. The XLFO can be
synchronized to the tempo of the plug-in host or set to run free. With
the options at the top-right corner
of the frequency button you can choose the different
settings:

Free running mode will allow values from 0.02 to 500 Hz, so the minimum cycle length is
0.002
seconds.

When using any of the synchronized cycle lengths (16 to 1/64, measured in bars) the
frequency
knob changes into the Offset knob. It now acts like a cycle
length multiplier and therefore is
capable of changing the cycle length relative to the
host tempo, from half to two times the host
tempo. Click the dots around the knob to jump
to certain predefined offsets for dotted and triplet
synchronization. Note: the Offset
parameter is not a modulation target, but you can modulate the
Phase offset instead.

Balance
The outer ring of the frequency knob adjusts the time balance of the first and last halves of
the step
sequence. For example, when turned to the left, the first half of the wave form is
generated more quickly
than the last half.

MIDI sync
The XLFO can be restarted at any point using MIDI if the MIDI sync option is enabled at the
top-right
corner of the frequency knob. When activated a note-on MIDI message (e.g. pressing
a key) will restart
the cycle of the waveform (to the point set by the Phase offset
slider).

Snap
This function makes it possible to use the XLFO as an arpeggiator. When you enable Snap, a
small piano
keyboard appears, the range of the XLFO turns into 2 octaves, and steps "snap" to
notes on the piano
keyboard. Now when you modulate a frequency parameter, turn the slot level
to maximum, and the total
amount of modulation will exactly correspond to 2 octaves.

Glide
The global Glide knob acts like an overall glide offset. The amount of glide determines the
point within a
step at which the XLFO starts to interpolate to the value of the next step.
The global Glide value is added
to the glide value for individual steps to arrive at the
final glide value for each step. The final glide value
is limited between 0 (no
interpolation) and 1 (full interpolation). Because the global Glide value can range
from -1
to 1 it can completely overrule the individual step glide values at the extreme settings. It
is also
a modulation target which allows for very cool effects.

Phase offset
In the step editor you can see a triangular shape. The vertical line of the shape indicates
the beginning of
each cycle. You can move this triangular shape, and thus change the
beginning of a XLFO cycle. This
phase offset is a modulation target, so when the XLFO
frequency is set to 0, you can use another
modulator to cycle through the different
steps.
Tip: Like with knobs, you can
Ctrl/Command-click on the phase offset slider to reset it.

At the top right of the global settings, the Presets button  provides access to the XLFO section presets. The
Remove button  deletes the XLFO source. By default, the XLFO
starts with two steps that make a sine wave.
You can customize this by overwriting the predefined
Default section preset.

Editing Steps
You can shape the waveform of the XLFO in almost any way you want by editing the individual
steps.

Drag a step up or down to change the value for the step.

Click a step to select it.
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Hold down Ctrl (Command on Mac) and click a step to select
multiple steps. Hold down Shift and click
a step to select a
consecutive range of steps.

Click next to a step to deselect all steps.

Click the + button at the end of all steps to add a new
step. The new step is added to the right of the
selected step, or at the end of all steps.

Click the - button at the end of all steps to remove the
selected steps. If no steps are selected, the last
step is removed.

If one or more steps are selected, the XLFO expands to show the step
interface where the parameters for the
selected steps can be edited:

Random
The Random button enables random values for this step. If
enabled, the XLFO will use a new random
value for the step each time it encounters it. The
display also changes to show that the value is chosen at
random (see step 3 in the screen shot
above).

Value
The Value knob adjusts the value of step. This is the same as dragging the step up and
down, except that
with multiple selected steps, the value of all steps is set to the same
value. In contrast, when you drag
multiple selected steps, the relative distance is kept the
same.

Curve
The Curve button selects the curve that is used to interpolate to the next step when the final
glide value
is higher than 0: Linear, Sqr, Sqrt and Sine.

Glide
The Glide knob sets the per-step glide value. This is combined with the global glide value
to determine at
which point the XLFO starts to interpolate towards the next step.

To start exploring the many sound shaping possibilities start with an XLFO that modulates a Drive knob or
Crossover Frequency to make the sound change
over time. You'll be amazed by the many possibilities. Have a
look at the presets to see the XLFO
in many different setups to get an idea of what it can do for you and start
creating your own
sequences!

Next: Envelope generator

See Also
Modulation
Drag-and-drop modulation slots
What-you-use-is-what-you-see
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Envelope generator
The envelope generator (EG) generates a traditional ADSR envelope. The envelope being the way
in which the
level changes with time and is controlled by the Attack, Decay,
Sustain and Release parameters. Its function is
to modulate a parameter over time,
based on MIDI input or the amplitude of the input signal or side chain
signal that triggers
it.

To add an envelope generator as a modulation source, click the + button in
the source selection bar and click
New Envelope
Generator.

The following EG parameters are available (hold the mouse over a control point in the EG
display to see which
parameter it affects):

Trigger
The EG can be triggered by three different kinds of input: MIDI note events, the main input
signal, or the
signal from the side-chain input. When MIDI is selected, the Threshold knob is
hidden. Depending on the
type and amplitude of the incoming signal you need to adjust the
threshold for optimal functioning. Look
at the top segment of the source button for the EG to
see when it is in the triggered (Attack-Decay-
Sustain) state. See also External side chaining.

Delay
The time it takes for the attack to start after the key is pressed (or triggered when the
side-chain signal
exceeds the threshold).

Attack
The Attack portion of the envelope is the time taken for the amplitude to reach maximum
value. For
percussive effects, the attack time should be as short as possible.

Decay
After the sound has reached its maximum level, it starts to decay until it reaches the
Sustain level at a
time set by the Decay time setting.

Sustain
This is the level reached after the decay time. The EG will hold this level as long as a key
is pressed. Note
that this parameter specifies a volume level rather than a time period.

Hold
Once the key is released, the value will remain at the sustain level for a time set by the
hold parameter.

Release
After the hold time the sound resumes its decay, this time at a new rate determined by the
Release
setting.

Tips

When adjusting the EG control points, you can hold down the Shift key to fine-tune
a setting, just like
with regular knobs.

To let a sustain pedal control the EG, you can hook it up to the Hold setting. The
recommended way to do
this is via a MIDI source.

At the top right of the EG interface, the Presets button  provides access to the EG section presets. The
Remove button  deletes the envelope generator. You can
customize the default EG settings (used when
creating a new EG) by overwriting the predefined
Default section preset.

Next: Envelope follower

See Also
Modulation
Drag-and-drop modulation slots
What-you-use-is-what-you-see
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Envelope follower
The envelope follower modulation source outputs an envelope signal based on the plug-in input
or side-chain
audio level. You can set the Attack and Release parameters to 'smooth
out the bumps'.

To add an envelope follower as a modulation source, click the + button in the source selection bar and click
New Envelope Follower.

The two buttons at the top of the EF source interface select which signal is used to trigger
on: the main input
signal or the signal from the side-chain input. See also External side chaining.

At the top right of the source interface, the Presets button  provides access to the EF section presets. The
Remove button  deletes the envelope follower. You can
customize the default EF settings (used when creating
a new EF) by overwriting the predefined
Default section preset.

Next: MIDI source

See Also
Modulation
Drag-and-drop modulation slots
What-you-use-is-what-you-see
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MIDI source
The MIDI source is a powerful modulation source if you want more control over FabFilter Saturn
using a MIDI
keyboard or MIDI control knobs. Note that you first need to route data from a MIDI
track to Saturn in your
host.

To add a MIDI source as a modulation source, click the + button in the
source selection bar and click New
MIDI
Source.

MIDI Input
Normally the MIDI source lets you use MIDI input such as velocity, pitch bend and modulation
wheel to
influence any parameter that can be modulated.

Controller number
... but when you set the input selection to Controller, it lets you use any MIDI controller
as a modulation
source.

Response curve
The response curve can be adjusted to get the desired control over the MIDI source output.
For example,
when used with velocity as MIDI source the linear, exponential, logarithmic,
square, square root or sine
curves make great dynamic differences.

Using a MIDI source is different from MIDI Learn because there is
no direct control of a knob via MIDI but it
uses a modulation slot instead. This way you can add
modulation to an already modulated destination. Or you
can use the full rotation of a knob while
actually modulating a smaller range. This can be a good way to control
say, a band level or EG
attack for which you sometimes want to make small changes with great precision.

At the top right of the source interface, the Presets button  provides access to the MIDI source section
presets. The Remove button  deletes the MIDI source. You can customize the
default MIDI source settings
(used when creating a new MIDI source) by overwriting the predefined
Default section preset.

Tips

To let a sustain pedal control an envelope generator, use a MIDI
source. Set the input to Controller, and
the controller number to 64. Now, drag the source drag button for the MIDI source to the hold control
point of the envelope generator, and set the slot level to maximum. Of course, you can also set
up more
sophisticated behavior of the sustain pedal, for example by modulation the release
setting instead of
hold: the possibilities are endless.

The VST 3 version of FabFilter Saturn doesn't support per-note aftertouch modulation.

Next: XY Controller

See Also
Modulation
Drag-and-drop modulation slots
What-you-use-is-what-you-see
MIDI learn
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XY Controller
The XY Controller makes for more tweaking fun. It's a classic, and we didn't dare to leave it
out! It can control
two parameters with one mouse movement. When browsing presets don't forget to
listen to the sound
mangling possibilities provided by these controllers.

To add an XY controller as a modulation source, click the + button in the source selection bar
and click New XY
Controller.

Because the XY controller has two "outputs", it also has two source drag buttons labeled X and
Y. The slots for
the XY controller are grouped in two rows, with the X-slots at the top. For
example, in the screen shot above,
the X axis controls the output panning, while the Y axis
controls the level.

The Remove button  deletes the XY
Controller.

Tips

To reset the XY Controller to its default position, hold down the Ctrl key (Windows)
or Command key
(macOS) and click once.

When you want to adjust only one parameter on one axis, holding Shift will make it
easier to do so while
keeping the other parameter constant.

With MIDI learn, you can set up a hardware MIDI controller to
control the XY controller. So if your MIDI
controller has XY-functionality you can directly
control FabFilter Saturn with it.

Next: Mid/Side processing

See Also
Support
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Mid/Side processing
The Channel Mode button in the bottom bar selects between normal Left/Right processing and
Mid/Side processing.

Mid/side is a representation of stereo sound as the sum and difference of the two channels.
The concept has its
origin in stereo microphone techniques using two microphones (more about that
here on Wikipedia ) but also gives
us many options to change a stereo audio signal.

When you set the Channel Mode to Mid/Side, the incoming stereo signal (normal left and right
audio) will be
converted to mid (mono information; audio that's equally present in both
channels) and side (pure stereo
information; audio only present in either the left or
right channel). The mid information is processed by the internal
left channel, and the side
information by the right channel. Of course, after the internal audio processing, the
mid/side
signal is converted back to stereo again.

Any conventional stereo signal can be converted to Mid/Side stereo, and back again, with no
loss of information.
Using the Mid and Side channels to treat them differently gives many
creative opportunities, providing tremendous
amount of control over the stereo spread.

You can use mid/side processing in FabFilter Saturn to achieve various useful and creative
effects. For example,
with the Pan ring around the Drive knob, you can drive the stereo image of
a sound while keeping the mono/mid
signal intact. Anything is possible!

Next: Input/output controls

See Also
Band controls

23

http://en.wikipedia.org/wiki/Stereophonic_sound#M.2FS_technique:_Mid.2FSide_stereophony
http://en.wikipedia.org/wiki/Stereophonic_sound#M.2FS_technique:_Mid.2FSide_stereophony


Input and output controls
Besides the MIDI learn and Channel Mode buttons, the bottom bar controls various input/output
options and
settings.

 

Auto Mute Feedback
The Auto Mute Feedback option reduces the feedback used in the distortion bands if there is no
incoming
audio signal. Depending on the amount of feedback and type of distortion processing,
the plug-in can
start to self-oscillate endlessly. The auto-mute feature enables you to use
extreme feedback settings
while ensuring that the continuous ringing will stop when you stop
playback in your host.

HQ
The HQ (high quality) mode controls oversampling of the internal distortion algorithms. Adding
distortion
to a signal introduces digital aliasing effects, especially when applying a lot of
drive. Enabling HQ mode
will drastically reduce aliasing artifacts by oversampling the internal
saturation section 8 times, at the
cost of using more CPU power and introducing a very small
latency.
Note: The HQ setting is not changed when you skip presets, but you can save
its initial setting by
overwriting the default
preset.

Audition
The audition switch (recognizable by its headphones icon) lets you listen to either the normal
output
signal (default setting), the input signal (bypassing the entire plug-in) or the side
chain signal. When
setting up side chaining in your host this is very useful to confirm that
the correct side chain signal is
routed to the plug-in.

Input
The input button shows the current input gain and lets you adjust it from -36 dB to +36 dB. To
change
the gain, simply drag the button up and down. For precise adjustments or to change the
panning, click
the input button once to open a pop-up window with the actual input/pan knobs.
Click the button again to
let the pop-up window disappear. The input and pan knobs are also
modulation targets.

Output
The output button shows the current output gain, also adjustable from -36 dB to +36 dB. It
works the
same as the input button and is also a modulation target. Note that you can overdrive
the filters by
increasing the input gain and reducing the output gain at the same time.

Mix
You can use the mix button to mix some of the original (dry, unprocessed) input signal back
into the
output signal, reducing the amount of filtered (wet) signal. Like the input and output
buttons, this is also
a modulation target.

Next: MIDI learn

See Also
Overview
Modulation
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MIDI Learn
Controlling FabFilter Saturn's parameters directly with MIDI is very easy using the MIDI Learn feature. With
MIDI Learn, you can associate any MIDI controller with any parameter.

Click the MIDI Learn button in the bottom bar to enter MIDI Learn mode. The
interface dims and the
parameters that can be controlled are highlighted. Each parameter has a
small text balloon that displays the
associated controller number. Now do the following to
associate a controller number with a parameter:

1. Touch the control of the desired parameter in the interface that you wish to control. A
red square will
mark the chosen parameter.

2. Adjust the slider or knob on your MIDI keyboard or MIDI controller that you want to
associate with
that parameter.

That's it! The parameter will now be controlled with the MIDI controller. You can now go back
to step 1 to
associate a different parameter. Note that there is no warning when you associate a
different knob with a
controller number that is already used. It will just be replaced.

To exit MIDI Learn mode, click the MIDI Learn button again, or click Close at the top of the
interface.

Click the small menu drop-down button next to the MIDI Learn button to access the MIDI
Learn menu:

Enable MIDI
This globally turns MIDI control of parameters on or off: useful in hosts that automatically
send all MIDI
events on a track to all effect plug-ins associated with that track as well.

Clear
This submenu shows all parameter associations and lets you delete individual associations or
clear all
associations in one step.

Revert
Reverts to the last saved MIDI mapping (or the state when the plug-in was started).

Save
Saves the current MIDI mapping so Revert will go back to this state. The current mapping is
automatically saved when closing the plug-in.

Routing MIDI to effect plug-ins

For MIDI Learn to work properly, the plug-in need to actually receive MIDI of course.
Depending on your host,
it can be quite difficult to route MIDI data to effect plug-ins. Here's
how to do it in the most important hosts:

Logic Pro
Instead of adding FabFilter Saturn to one of the insert slots, create a new Instrument
Track, and click
on the Instrument slot. Then choose AU MIDI-controlled
Effects > FabFilter > FF Saturn. Now, the
plug-in receives MIDI. To get audio
into the plug-in, click the 'Side Chain' drop down menu in Logic's
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plug-in
header and choose the actual input track. Next, you can mute that original track, so you only
hear the audio through the plug-in. The only downside is that plug-ins with an external
side-chain cannot
use it anymore.

Cubase
Simply create a new MIDI track and set its output to the Saturn instance you
would like to control via
MIDI.

Pro Tools
Create a new MIDI track. From the MIDI input drop down menu, choose your MIDI
device (if not
already selected) and from the MIDI output drop down menu, choose FabFilter
Saturn -> channel 1 for
the instance you would like to control.

Ableton Live
First of all, create a new MIDI track. From the 'MIDI from' drop down menu,
choose your MIDI device (if
not already selected). Then, in the 'MIDI to' drop down menu,
choose the Audio track that has FabFilter
Saturn on it. Note: only the first plug-in on any
track can receive MIDI.

Next: Undo, redo, A/B switch

See Also
Overview
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Undo, redo, A/B switch
The Undo and Redo buttons at the top of the FabFilter Saturn interface enable you to easily undo changes you
made to the plug-in. With the A/B feature, you can quickly switch between two different states of the plug-in.

The Undo button at the left will undo the last change. Every change to
the plug-in (such as dragging a
knob or selecting a new preset) creates a new state in the
undo history. The Undo button steps back
through the history to restore the previous states
of the plug-in.

The Redo button cancels the last undo command. It steps forward through
the history until you are back
at the most recent plug-in state.

The A/B button switches from A to B and back. Before switching, the current state of
the plug-in is
saved, so if you click this button twice, you are back at the first state. The
button highlights the currently
selected state (A or B). In the example above, the A state is
active.

The Copy button copies the active state to the inactive state. This marks the
current state of the plug-in
and allows you to go back to it easily with the A/B button. After
clicking Copy, the button disables itself to
show that both states are equal, so there is
nothing to copy anymore.

Notes

If the plug-in parameters are changed without using the plug-in interface, for example with
MIDI or
automation, no new undo states are recorded.

The Undo and Redo buttons will disable themselves if there is nothing to undo or redo.

Next: Loading presets

See Also
Overview
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Loading presets
Plenty of presets are provided with FabFilter Saturn, giving a good idea of what you can do.
You can either use
the presets as they are, or tweak them further to create your own unique
sounds.

To load a preset, click the preset button. The presets menu will appear with all available
presets. Click a
menu item to load that preset. The currently selected preset is highlighted
with check marks.

To explore the presets one by one, click on the little arrow buttons to the left and right
of the main preset
button. This will load the previous or next preset in the menu.

The preset button shows the name of the current preset. If you have changed the preset by
adjusting one or
more parameters, the name is dimmed to indicate that this is not the original
preset anymore.

Tips

The Default Setting preset is loaded automatically when FabFilter Saturn is started. To change the
default settings, simply overwrite this preset by clicking Options > Save As Default in the presets
menu.

To open a preset outside the presets folder, click
Options > Open Other Preset. This might be useful if
someone sends you a
preset by email, for example.

If somehow the factory presets are lost or not installed properly, click Options
> Restore Factory
Presets in the preset menu to restore them.

MIDI Program Change and Bank Select

Loading a presets can also be done via MIDI, using Bank Select and Program Change messages.
Click Options
> Enable MIDI Program Changes in the preset menu to enable or
disable this feature. When enabled, the
corresponding bank/program numbers are shown in front of
the preset name (for example: (0/65) My Preset).
This means that you can load that
preset by first sending a Bank Select message to select bank 0 and then
sending a Program Change
message to select program 65.

Important: All the presets in your preset folder are numbered automatically,
starting with bank 0 and program
0. This way, you are able to access any of the presets via MIDI.
However, this also means that when you add
new presets to the menu, bank/program numbers of other
presets might change. Be aware of this when
recording program changes in a session! We recommend
to create a dedicated folder in your presets folder for
your program changes, and name it with
two leading underscores (e.g. "__Programs") to ensure it's the first
folder in your preset collection and the presets in this folder start with bank 0 and program 0.

Next: Saving presets

See Also
Overview
Acknowledgements
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Saving presets
You can easily extend the included presets with new settings to build your own library of
presets for FabFilter
Saturn that you can reuse in various projects. This is also a good way to copy settings across multiple instances
of FabFilter Saturn in a session.

To save the current setting as a preset, click the preset button, and then click Save
As. A standard Save dialog
will appear. Type a name for the new preset and click Save
to finish.

In the Save dialog, you can also rename and delete existing presets and create a new folder to
store presets in.
New folders will show up as new categories in the preset menu. (On macOS,
this should be done with the
Finder.)

See How presets are stored to determine the preset
folder location and learn more about factory presets.

Next: Section presets

See Also
Loading presets
Overview
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Section presets
To make designing sounds for FabFilter Saturn easier, you can save section presets for
different sections of the
plug-in. In this way you can, for example, easily re-use certain
settings. To load and save section presets, click
the Presets  button that appears in each section. This will display a presets menu for
that section. FabFilter
Saturn comes with a selection of ready-made section presets, but we
encourage you to save your own presets
to build a custom library of sound building blocks.

Supported sections are:

Band controls

XLFO

Envelope generator

Envelope follower

MIDI source

When you add a new modulation source, it loads its Default section preset.
You can customize the initial
settings just by overwriting that preset using the Save dialog.

Section presets are stored in the Application Data folder (Windows) or Application
Support folder (macOS) for
the current user. For example, the full path to the section presets on Windows 10 is C:\Users\
<User>\AppData\Roaming\FabFilter\Saturn\Component Presets (note that this folder is hidden by default). You
cannot change the section preset paths.

Next: How presets are stored

See Also
Loading presets
Overview
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How presets are stored
Presets for FabFilter Saturn are stored in separate files with the .ffp extension (for
FabFilter Preset). All presets
reside in subfolders in the main preset folder. The subfolders
will show up as separate categories in the preset
menu. You can also further divide the
subfolders into categories.

You can manage the preset files just like other files on your computer. The easiest way to do
this is in the Save
dialog that appears if you are saving a preset. The preset menu will
automatically reload itself with the changes
when the dialog is closed.

Furthermore it is very easy to share your newly created presets with other users since
FabFilter presets use the
same file format on both Windows and macOS.

The default location of the main preset folder is My Documents\FabFilter\Saturn for
Windows, and
~/Library/Audio/Presets/FabFilter/FabFilter Saturn for macOS. To change this location, first copy all presets to
the desired new location, and then click Options > Change Preset Folder in the preset menu and select the
new folder.

Restoring factory presets

If you have accidentally lost the factory presets, you can easily restore them by clicking
Options > Restore
Factory Presets in the preset menu. This will install all
factory presets again.

Next: Purchasing FabFilter Saturn

See Also
Saving presets
Overview
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Purchasing FabFilter Saturn
Once you have downloaded and installed the evaluation copy of FabFilter Saturn, you may evaluate it during 30
days. Every time you start the plug-in, you will see the following
dialog:

While there are still days left, you can click Evaluate to start working with
the plugin. If you want to keep
using FabFilter Saturn after the evaluation period, you must buy a copy in the online FabFilter Shop by clicking
the Buy Now button in the
evaluation dialog.

Go to the FabFilter Shop and
purchase FabFilter Saturn now 

We accept credit cards from all major companies, check payments, wire payments, and PayPal.
The FabFilter
Shop uses secure connections and encryption: therefore your personal information is
completely safe.

Within a few minutes after you have purchased your copy, you will receive an email containing
your personal
license key. You use this license key to turn the evaluation copy into a fully
registered version without the
evaluation dialog and the 30-day trial restriction.

Note: If the evaluation period has expired but you didn't have the chance to
properly evaluate the plug-in, you
can request a new evaluation period by contacting us at
info@fabfilter.com .

Next: Entering your license key

See Also
Support
License agreement
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Entering your license key
After you have purchased FabFilter Saturn in the online FabFilter Shop , you will immediately receive an e-
mail
containing your personal license key. This license key will turn the evaluation version into a
fully registered
plug-in.

Start FabFilter Saturn and click Enter License in the evaluation dialog,
or click Enter License on the Help
menu if the plug-in is already running.

Copy the license information from the email you have received and paste it into the text
field. Make sure
that you are copying the entire license key including the Product and
Licensee lines! If you are not sure
what text to copy, just copy and paste the whole
e-mail.

After you have entered your license information, you will need to restart the plug-in host, so
make sure you
save your settings if needed. From now on, you will be able to use FabFilter Saturn for an unlimited period of
time with full support via email.

Tips

After your purchase, you can always retrieve your license key again by logging into your
personal
FabFilter account
 . Here you can also keep track of
all your orders and take advantage of great
discounts when buying other FabFilter
plug-ins.

To deauthorize your license key and remove it from the computer, click
Deauthorize on the Help menu.
If you temporarily needed to install your
license on another computer, or if you have transferred your
license to someone else, this is
the way to deinstall your personal license key safely.

Next: Support

See Also
Purchasing FabFilter Saturn
Support
License agreement
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Support
If you need help with problems or questions, and the help file does not provide an answer,
please visit the
support pages on our web site.

Go to FabFilter Support


From here, you have direct access to the customer support forum, very useful tutorial videos
for all FabFilter
plug-ins, online and PDF versions of all our help files, and a section with
extra downloads (such as presets,
controller templates, older plug-in versions).

For sales-related questions and technical support, you can also contact FabFilter directly at
info@fabfilter.com.

Reporting a bug

If you have encountered a bug in FabFilter Saturn, first of all make sure that you are using the latest version of
the plug-in, which you can find at www.fabfilter.com/download . You can easily check the version of
FabFilter
Saturn that you are using by clicking Help > About in the plug-in interface. If the bug is still present in the
latest version, please send us an e-mail at info@fabfilter.com and include as much technical
information as
possible: operation system and version, host software and version, steps to
reproduce the bug, etc. Thanks in
advance!

Next: Manual installation

See Also
Overview
About FabFilter
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Manual installation
When installing FabFilter Saturn, the installation program will try to copy the plug-in into
the appropriate plug-
ins folders, and in most cases your host will recognize FabFilter Saturn
automatically. Otherwise, please follow
these instructions:

Windows

On Windows, most hosts have their own VST plug-ins folder. So if you are using Windows and
your host does
not recognize FabFilter Saturn, you need to locate the proper plug-ins folder for
your host first (it is usually
shown in the Preferences or similar dialog). Then, copy the file
FabFilter Saturn.dll from C:\Program
Files\FabFilter\Saturn (or C:\Program Files
(x86)\FabFilter\Saturn if you are using a 32-bit host on 64-bit
Windows) to the plug-ins
folder that you have found and restart the host so it can reload all its plug-ins. For
the AAX
version of Saturn, copy the FabFilter Saturn.aaxplugin folder to the common Pro Tools AAX
plug-in
folder on your computer.

You can simply uninstall plug-ins or bundles via the Control Panel.

macOS

On macOS, plug-ins are installed in the standard plug-in folders in the system Library
folder. These are the only
possible correct locations:

Audio Units: /Library/Audio/Plug-Ins/Components

VST/VST3: /Library/Audio/Plug-Ins/VST and /Library/Audio/Plug-Ins/VST3

AAX: /Library/Application Support/Avid/Audio/Plug-Ins

Note: AU and VST/VST3 plug-ins may also be placed in the user's Library folders under
/Users/<username>/Library/Audio/Plug-Ins.

To uninstall the plug-ins from your Mac, you can just delete the specific FabFilter plug-in
files at the above
locations. Finally, if you really want to delete all data written by our
plug-ins, you can remove the following
folders/files from the user Library folder as well:

/Users/<username>/Library/Audio/Presets/FabFilter/FabFilter Saturn

/Users/<username>/Library/Application Support/FabFilter/Saturn

/Users/<username>/Library/Preferences/com.fabfilter.Saturn.1.plist

Note: Since OS X 10.7 (Lion), the system and user Library folders are marked
as hidden by default. To make
them visible again in Finder, open Terminal (found in
/Applications/Utilities) and enter the following commands:

chflags nohidden /Library
chflags nohidden ~/Library

If you still have problems, contact FabFilter Support .

Next: VST plug-in versions

See Also
Quick start
Support
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VST plug-in versions
FabFilter Saturn is available in both VST 2 and VST 3 formats. They can be installed and used both at the same
time. The VST 3 format offers easy side-chaining and
is more CPU-friendly in some cases, but it can only be
used by hosts that support it, for example recent versions of Cubase, Studio One or FL Studio. The VST 2
format is compatible with a larger variety of hosts.

Both the VST 2 and VST 3 versions of the plug-in automatically adapt themselves to the channel layout of the
track they are inserted on (mono/stereo).

For the VST 2 format, there is a separate FabFilter Saturn (Mono) version
of the plug-in which always runs in
mono mode. This is included for backwards compatibility with existing sessions. For new sessions we
recommend to use the regular plug-in which automatically adapts itself to the track it is inserted on.

Next: External side chaining

See Also
Quick start
Manual installation
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External side chaining
FabFilter Saturn offers the possibility of feeding an external signal
to its side chain, so that you can make it
trigger on a different signal than the audio it is actually processing.
Feeding a signal to a plug-in's side-chain
inputs works slightly different in various hosts. This topic describes the procedure for some of the most popular
hosts around: Cubase, Logic Pro, Ableton Live and Pro Tools.

To explain how it works, we use a scenario with two tracks. The first one contains the audio that we want to
process with Saturn, which we'll call the main track from now. The second track contains the audio that we
want to route to Saturn's external side-chain input and use as trigger signal. We'll call this track the side chain
track.

After setting up everything according to the instructions below for your host, you can check whether everything
is routed correctly: play the audio and enable FabFilter Saturn's Audition button to listen to the side-chain
signal. Afterwards, disable the Audition mode again. Any envelope generators or
envelope followers that are set
to trigger on
the external side chain, will now respond to the side chain signal.

Cubase

Open Cubase and create a new empty project.

Add two audio tracks that we'll use as main track and side chain track.

Add audio files on both the main track and the side chain track. You can simply drag audio files from a
Finder/Explorer window onto a track.

Open the Mixer. In the main track, click on an empty insert slot and select the VST 3 version of FabFilter
Saturn in the Distortion menu (note the VST 3 icon which looks like ///).

Open FabFilter Saturn's interface and set up an
envelope generator or
envelope follower, triggered by the
external
side chain signal.

In the plug-in header, click on the Activate Side-Chain button (right of the R/W buttons) to enable the
external side chain in Cubase.

At the top of the Mixer, set the output for the side chain track to the side-chain input of FabFilter Saturn.

Logic Pro

Open Logic Pro and create a new empty project via File > New...

Add two audio tracks (via Track > New...) that we'll use as main track and side chain track.

Add audio files on both the main track and the side chain track. You can simply drag audio files from a
Finder/Explorer window onto a track.

Select the main track and add Saturn in the first Insert effect slot.

Open FabFilter Saturn's interface and set up an
envelope generator or
envelope follower, triggered by the
external
side chain signal.

In the right top corner of the plug-in interface header, in the 'Side Chain' menu, choose the side chain
track. Now, the signal from the side chain track is sent to FabFilter Saturn's external side-chain input.

Ableton Live

Open Ableton Live and start with an empty arrangement. We'll use Track 1 as the side chain track and
Track 2 as the main track.

From the folder menu's on at the left top of Ableton Live's interface, drag different audio clips to the first
empty slots of Track 1 and Track 2.

From the VST (or Audio Units) plug-in menu, also at the left top of Ableton Live's interface, drag FabFilter
Saturn onto Track 2, the main track.

Open FabFilter Saturn's interface and set up an
envelope generator or
envelope follower, triggered by the
external
side chain signal.

In Track 1 (the side chain track) in the 'Audio To' menu select 'Track 2' instead of the default 'Master'.
Now, an extra menu appears right below: choose 'FF Saturn 3/4' instead of the default 'Track In' to route
the track's signal to FabFilter Saturn's external side chain inputs.

Note: In the scenario above, you won't hear Track 1 (the side-chain signal) anymore, since its audio is
only routed to Saturn's side-chain inputs. To avoid this, use one additional track (e.g. Track 3), choose
'Track 1' from its 'Audio From' dropdown menu, and in the 'Audio To' menu select 'Track 2' instead of the
default 'Master'. Now, from the extra menu below choose 'FF Saturn 3/4'. Of course, you can now leave
Track 1's 'Audio To' setting to the original 'Master' so you will still hear the signal.

Pro Tools

Open Pro Tools and start a new empty session.

Create two audio tracks that we'll use as main track and side chain track. Add audio files to both track.
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Open the Mix window to display the tracks with their Insert slots and Sends slots.

In the first 'Sends' slot of the side chain track, choose 'Bus 1'. The track view for Bus 1 will open: set its
level slider to 0.0 dB so the bus actually produces audio!

In the first 'Inserts' slot of the main track, choose Harmonic > FabFilter Saturn.

Open FabFilter Saturn's interface and set up an
envelope generator or
envelope follower, triggered by the
external
side chain signal.

Now, in the 'Key Input' menu of the plug-in interface (just above the FabFilter logo), choose bus > Bus 1
instead of the default 'no key input'. Now, the audio from the side chain track is routed to Saturn's
external side chain input via Bus 1.

Next: License agreement

See Also
Input/output controls
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FabFilter Software License Agreement
This license agreement concerns and describes your rights and the conditions upon which you may use the
FabFilter software you selected. We advise you to read this entire agreement. By accepting this agreement or
by using FabFilter software, you agree to all
of these terms. If you do not accept and comply with these terms,
you may not use the FabFilter software or its features.

Applicability

This license agreement applies to all the FabFilter software, plug-ins and programs you may use during the
Evaluation period, and/or thereafter subject to an acquired license key to certain FabFilter software of any
version, including any and all upgrades, supplements or services, unless other terms come with such versions,
upgrades or
supplements.

Licenses

The software will be licensed to the Customer, not sold. With the FabFilter license key, you will be granted after
full payment the right in perpetuity (meaning that the license agreement shall not automatically expire) to
install, run and use the software concerned
under certain conditions. These conditions vary subject to the
license you acquired. FabFilter distinguishes the following licenses:

A Personal License is a named license to the software concerned, granting access to the software on an
unlimited number of Devices, as long the license is used by the designated person who acquired the
FabFilter license key. Usage of the Personal license by someone else but the designated licensee is an
infringement of the rights of FabFilter. The Customer should at all times protect its license key from theft
and/or abuse.

A Site License is a non-personal license to the FabFilter software concerned, acquired on the name of an
institution or entity, who is the licensee. A Site License will grant access to the FabFilter software on a
certain maximum number of designated Devices, as specified in the license key itself (e.g. "20 seats"). If
the Site License is used on computers/servers for any form of automated processing, the licensee may
not make any plug-in controls/parameters of the FabFilter software available to the end users of the
FabFilter software, i.e. only "black box" processing is allowed.

These FabFilter licenses, whether a Personal or Site License, will give you access to certain FabFilter software of
the specified major version. The license will include all future minor updates to the software (e.g. version 2.19
to version 2.20), which typically include bug fixes or small new features. The license will exclude any future
new major versions of the products (e.g. version 1.x to version 2.x). To allow yourself access to such new
major version of the software, a new FabFilter license to such major version must be acquired.

All FabFilter licenses, both Personal or Site License, give the Customer or end user the right to install and use
the FabFilter software to the extent it has been developed and under the conditions herein. Any rights not
explicitly granted to you, the Customer, remain with FabFilter, including but not limited to the right to alter,
reverse engineer, reverse compile, take apart, or disassemble the FabFilter software or any of the files in the
distribution.

A Bundle License is Personal or Site License for multiple FabFilter software products, which gives the Customer
or end user the right to install and use the specific software products that the bundle (e.g. Total Bundle)
contains at the moment of purchasing the Bundle License. Any software products or new major software
versions added to the bundle after that date cannot be claimed as part of the prior acquired Bundle License. A
Bundle License (if not Educational or NFR) can only be transferred as a whole, using
a License Transfer.

An Upgrade License is a Personal or Site License for a new major version of FabFilter
software. You may only
use an Upgrade License if you have a license for the previous
major version of the same FabFilter software.

Educational (EDU) and NFR licenses

A Personal or Site License can be marked as EDU (Educational) or NFR (Not For Resale), meaning the following:

A Personal or Site License marked as Educational License is equal to the respective Personal or Site
License, with the only exception that the Educational License may not be transferred to a third party.

A Personal or Site License marked as NFR ("Not For Resale"), is typically intended for journalists that wish
to review the FabFilter software. A License marked as NFR is equal to the respective Personal or Site
License, with the only exception that the NFR License may not be transferred to a third party.

Duration and Evaluation

As specified in the specific terms per license, all licenses will be granted for perpetuity (meaning that the
license agreement shall not automatically expire), as long
as all conditions herein are respected.

The Evaluation period is a period of thirty (30) days commencing on the first day of using the software
concerned and automatically expiring 30 days thereafter. After the Evaluation period has expired and no
FabFilter license key has been acquired, the software will stop working and should be removed from your
computer.

In addition to any and all such possibilities that FabFilter may have in accordance with the law, FabFilter may
terminate without prior notice or warning in case of abuse of the FabFilter software as well as in case of
(personal) bankruptcy.
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Support

FabFilter shall give its reasonable commercial efforts to service any major version of any
FabFilter software
including email support. FabFilter is entitled to terminate support for
any major version of any FabFilter
software at any time at its sole discretion.

License Transfer

A Personal or Site License (not Educational or NFR) may be transferred to a third party. You will have to buy a
License Transfer to activate the "transfer"-option in your FabFilter account . After this option has been
activated you will be able to transfer your license to any third party.

Third Party Software

VST is a trademark of Steinberg Media Technologies GmbH. RTAS and AAX are trademarks of Avid Technology,
inc. Audio Units is a trademark of Apple Computer, inc.

Applicable Law

This license agreement is governed by Dutch law. The courts of Amsterdam are authorized courts to rule on
any dispute that may arise from this license agreement.

Disclaimer

TO THE MAXIMUM EXTENT PERMITTED BY LAW, FABFILTER, FREDERIK SLIJKERMAN AND FLORIS KLINKERT,
AUTHORS OF THIS FABFILTER PRODUCT, SPECIFICALLY DISCLAIM ALL WARRANTIES, EXPRESSED OR
IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF NON-INFRINGEMENT,
MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE. FABFILTER, FREDERIK SLIJKERMAN AND
FLORIS KLINKERT, DO NOT WARRANT THAT THE SOFTWARE WILL MEET YOUR REQUIREMENTS OR THAT THE
SOFTWARE WILL OPERATE ERROR-FREE OR UNINTERRUPTED. TO THE MAXIMUM EXTENT PERMITTED BY LAW,
FABFILTER, FREDERIK SLIJKERMAN AND FLORIS KLINKERT, SHALL NOT BE LIABLE FOR ANY DAMAGE A
FABFILTER PRODUCT MAY CAUSE OR DAMAGES THAT MAY ARISE OUT OF THE USE OF A FABFILTER PRODUCT
OR INABILITY TO USE A FABFILTER PRODUCT, INCLUDING BUT NOT LIMITED TO SPECIAL, INCIDENTAL,
CONSEQUENTIAL OR OTHER DAMAGES. IN NO EVENT
FABFILTER, FREDERIK SLIJKERMAN OR FLORIS
KLINKERT WILL BE LIABLE FOR AN AMOUNT IN EXCESS OF TWO HUNDRED FIFTY EUROS (€ 250,00).

Next: Acknowledgements
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About FabFilter
Beautiful sound. Fantastic workflow. These are the foundations of FabFilter. We create
powerful audio plug-ins
with superb sound quality and innovative interfaces.

A unique perspective

At FabFilter, we make the best possible tools for music production and audio processing. To
achieve this, we
continually rethink and challenge industry standards: we've never been afraid of
reinventing the wheel.
Considering every little detail, we tune our algorithms and interfaces
until they sound perfect, look amazing and
feel great to work with.

It's the sound that counts

Above everything else, you need superb sound quality. That's why we put a lot of effort into
developing unique
audio processing algorithms, ranging from our famous resonating filters to
transparent high-end EQ and
dynamics processing.

Innovative interfaces, great design

Every FabFilter plug-in has an easy-to-use, well-designed interface aimed at providing
unsurpassed workflow.
Our plug-ins focus on the task you're performing at that specific moment:
they expose the features you need,
when you need them. And because of our special attention to
design, you'll be delighted every time you open a
FabFilter plug-in.

Don't take our word for it

We always set the highest standard for sound quality, usability and design to make truly great
products that
raise the bar on what audio software can do. That's why we're very happy with the
praise we've received from
users and press alike:

"In the decade since the release of its first plug-in, One, FabFilter has made an indelible
mark on the
music production landscape." — Computer Music magazine

"While many other software developers are busy trying to model hardware, FabFilter is
leaving them
in the dust by being visionaries and reaching into the future. FabFilter stuff is
just on another level."
— Jeff Sanders

"FabFilter has an enviable reputation for making easy-to-use, powerful tools." — Music Tech
magazine

FabFilter was founded in 2002 by Frederik Slijkerman and Floris Klinkert, and is based in
Amsterdam, The
Netherlands.
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